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Topaz B&W Effects is a Photoshop plug-in, which
means it won’t run by itself and requires a compatible
host program for use.
To Install
1. Close Photoshop or other image editing program if
you are using it.
2. Double-click on the Topaz B&W Effects folder to
access the installer, and then follow the on-screen
instructions.

Mac Dmg 		

Windows exe

3. Your Topaz B&W Effects plug-in will automatically be
installed in your Photoshop plug-ins folder.
4. After the installation, you will need to enter your
license or trial key.

Entering Your Key
Entering your trial key allows you to save your projects
and print them during your evaluation period. Entering
your license key allows you do the same, except without any time limitations.
1. Start by opening up an image in Photoshop.
2. Go to Filters -> Topaz Labs -> BW Effects 2 -> Menu
-> Enter key.
3. You can then copy and paste or type your key in.
Important: To install the product on a second computer, you will need to download Topaz B&W Effects and
then enter your same license key.
Host-Specific Installation
Topaz B&W Effects is also compatible with Lightroom,
Aperture and iPhoto. To use B&W Effects in any of
these programs you will need to download and install
the free Topaz Fusion Express compatibility add on.
You can get it online at: www.topazlabs.com/downloads

Important for Mac Users:
After installation, Topaz B&W Effects will be installed in
the following folder: “ Macintosh HD -> Library -> Application Support -> Topaz Labs -> BW Effects 2”.

In Windows, Topaz B&W Effects is supported by most
host applications that support Photoshop plug-ins.
This includes Paint Shop Pro, Photo Impact and Irfanview, although there are additional host programs that
may also support Topaz B&W Effects.

If your Photoshop is installed in a customized location,
you will need to manually create a shortcut (alias) link
inside folder “<Photoshop install folder> -> Plug-ins”
that links to “ Macintosh HD -> Library -> Application
Support -> Topaz Labs -> BW Effects 2 -> Plug-ins”.

To install B&W Effects in either Paint Shop Pro, Photo
Impact, or Irfanview first download Topaz B&W Effects
to the default location. Then, to configure it into each
program, follow the host-specific instructions on the
next page.
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How to install Topaz B&W Effects in Paintshop Pro
1. First launch PaintShop Pro / Photo Impact.

Installation
3. Choose C: \ Program Files \ Topaz Labs \ Topaz BW
Effects 2\Plugins and click “OK”.

2. Go to Menu file -> Preferences -> File Locations.
Select “Plug-ins” from the “File Types” list and click
“Add”.
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4. Topaz BW Effects is now available to use. Simply go
to Effects -> Plug-ins and select “B&W Effects 2”.
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How to install Topaz B&W Effects in Photo Impact
1. First launch Photo Impact.
2. Go to File -> Preferences -> General or use shortcut
key F6.

Installation
Then click on the
button and browse to find the
B&W Effects plug-in folder located in: C:\Program Files\
Topaz Labs\Topaz BW Effects 2 plug-ins and click “OK”.

4. Restart Photo Impact. Go to Menu -> Effect to access
the plug-in.

3. Select Plug-ins from the Categories list.
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How to install Topaz B&W Effects in Irfanview
1. Make sure that you have downloaded and installed
the 8bf plug-in add-on, available on the Irfanview
webpage. (http://www.software.com/irfanview-plugin)

Installation
3. In the screen that pops up, select “Add 8BF filters”
and navigate to the C:\Program Files\Topaz Labs\Topaz BW Effects 2 \Plug-ins folder and click “OK”. You
will then see “Topaz B&W Effects 2” in the Available/
Loadable 8BF Filters section.
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2. Open Irfanview and go to Image -> Effects -> Adobe
8BF filters.
4. To use Topaz B&W Effects 2 in the future, simply go
to Image -> Effects> Adobe 8BF filters again and select
“Topaz B&W Effects 2”.

Uninstalling
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To uninstall Topaz B&W Effects follow these instructions:
Mac
1. Quit Photoshop (or other editing program).
2. Navigate to the Topaz Labs support files and frames
located at: Macintosh HD -> Library -> Application Support -> Topaz Labs.
3. Locate the Topaz B&W Effects 2 folder and move it
to the trash. You will need to enter your system password to OK this change.
4. Navigate to your Photoshop plug-ins folder located
at: Applications -> Photoshop -> Plug-ins
5. Locate any leftover Topaz B&W Effects 2 files and
move it to the trash.

2. Click on the Start Menu and select Control Panel.
3. Select Programs, then Uninstall a Program.
4. Select Topaz B&W Effects 2 and click remove.
Windows 7*
1. Quit Photoshop (or other editing program).
2. Click on the Start Menu and select Control Panel ->
Programs -> Programs and Features.
3. Select Topaz B&W Effects 2 and click uninstall.
*Please note that if you also have the 64-bit version of
B&W Effects 2 installed, then you will need to first uninstall this version before you can uninstall the regular
version.

Windows XP*
1. Quit Photoshop (or other editing program).
2. Click on the Start Menu and select Control Panel.
3. Double-click on Add / Remove programs.
4. Select Topaz B&W Effects 2 and click remove.
Windows Vista*
1. Quit Photoshop (or other editing program).
Before

After
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Topaz B&W Effects
About Topaz B&W Effects
Topaz B&W Effects is a black and white converter and
image enhancer that can achieve a variety of looks,
making it easy to create stunning black and white compositions.

More than your traditional black and white conversion
tool, Topaz B&W Effects offers more tools and flexibility for a diverse range of looks from traditional to
stylized and beyond.

The Primary Functions of Topaz B&W Effects Include:
1. Dynamically convert images to black and white with
maximum contrast control.
2. Balance and enhance tonal range of grays while individually controlling the range of blacks and whites.
3. Create an authentic feel of film by applying real grain.
4. Enhance images with maximum detail and depth.
Before - By Topaz User Steve Rich

5. Selectively enhance images with color, dodge, burn,
smooth or detail.
6. Add creative styles - like HDR, diffusion, painterly effects and more.
7. Add finishing effects like vignettes, boarders, quad
toning and more.

Visit the B&W Effects Gallery to see more examples:
http://gallery.topazlabs.com/keyword/bweffects

After - By Topaz User Steve Rich
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B&W Effects Features
1. Smart Brush. Intuitive selective adjustment brush
for burning, dodging, smoothing, selective color and
selective detail - plus edge-aware options.
2. Advanced Grain Engine. For the most authentic film
grain look.
3. Preset Collections. Presets are organized into 7
unique collections.

Introduction
13. Preset Navigation. Use the up / down arrow keys
to navigate the preset list and display the selected
preset thumbnail (in preset preview window). Use
the return (Enter) key to apply the currently selected
preset.
14. Enable / Disable Tool Tips. Option to enable or disable the pop up tool tips.
15. Quick Slider Reset. Double click on the slider
name to reset default slider values.

4. Effect enable/disable. Clickable preview options
that allow you to hide or view a set of adjustments for
easy comparison.
5. Stage-based layout. For a simple and streamlined
workflow. All of the tools are broken down into steps
to help ease you through the editing process.
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6. Split Screen. Use the 2-screen split view for easy
before and after comparison.
7. Preset Enable / Disable option. Option to enable
or disable the preset preview processing at program
startup.

Before - By Topaz User Gavin Seim

8. Localized reset all buttons. Reset only the parameters in a specific tab.
9. Undo / Redo buttons.
10. Collapsible side panels. Expand and collapse the
preset panel and the tool panel for an adjustable
workspace.
11. Snap / Recall collection. Save up to 99 snapshot
settings for comparison.
12. Auto Updater. Get software updates instantly.

After - By Topaz User Gavin Seim
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Introduction

New B&W Effects 2 Features
1. User Interface Design. With B&W Effects v2, we are
introducing a much cleaner, more efficient interface
to improve useability and workflow.
2. Preset Preview. A larger, floating preview is displayed when hovering over presets.
3. Preset QuickLook View. A full-screen, pop-up grid
view that shows all the presets in a certain collection
at the same time.
4. Grain Enhancements. The grain algorithm has been
enhanced, allowing for even more realistic grain creation from the true grain library.

Before Topaz B&W Effects

5. Color Filter and Sensitivity Enhancements. The
strength and quality of both the Color Filter and Color
Sensitivity have been improved.
6. Quick Tools. Adjust contrast, brightness, adaptive
exposure and more without
having to access the full adjustment panel.
7. Loupe. Quickly view a small portion of an image at
100% zoom.
8. Viewing Enhancements. Easily change the main
preview background color and hide side panels for
less distraction.

After Topaz B&W Effects
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Smart Brush
Topaz B&W Effects includes edge-aware brush techology for local adjustments. The five-in-one tool brush
is designed to help you easily and effectively achieve
selective adjustments during your workflow. Also
includes local undo/redo (up to 4 steps) and a local
reset all button.

Adjustment Types
This tool has five different modes that allow you to
determine the exact type of adjustment you want to
apply to help put the emphasis where you want it in
your image. By simply brushing (click and drag) on
any area in your image you can easily make localized
adjustments.
Dodge - lightens areas of an image
Burn - darkens areas of an image
Color - reintroduces original image color
Detail - enhances detail in image
Smooth - smooths out areas of an image
Using the Brush
To use the selective brush, you will need to select
your adjustment type. For Dodge, Burn, Detail and
Smooth you will also set the Overall Strength slider
to determine how strong the affect will be applied to
your image. Once your values are set you can set your
brush characteristics - brush size, opacity, hardness
and edge aware. Then go ahead and draw across any
area in your image to apply the effect.
Edge Awareness
Controls how edge aware your brush is. Use a higher
value for more precise selections and a lower value
for a more natural stroke and transition.
Removing Your Selections
If you switch to the Eraser this will allow you to erase
adjustments made.
The mask view allows you to see the areas where your
selective adjustments are being appiled in your image.

11

Features

Topaz B&W Effects

User Manual

Advanced Grain Engine
B&W Effect’s grain engine applies true or simulated
film grain to the image. The grain options were developed from scans of real film for an authentic look
and feel. Choose from the library of popular true grain
types. You can use the sliders to further customize
the grain contrast and size in your image.

Before - By Topaz User Jim LaSala

After - By Topaz User Jim LaSala
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Adaptive Exposure
B&W Effects integrates the power of Topaz Adjust’s
Adaptive Exposure to enhance the dynamic range of
your image. This allows you to enhance both detail and
depth and can create HDR-style looks.
Apply a variety of tone mapped effects using the
unique sliders to adjust the range of the highest and
lowest luminance regions where detail is visible. You
can also correct exposure, balance lighting and redefine tonal values.
Before - By Topaz User Jim LaSala

After - By Topaz User Jim LaSala
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Curve Tool

Creative Effects

B&W Effects also integrates the powerful and flexible Curve Tool + histogram into the workflow. Using
the Curve Tool you can adjust image tonality to help
emphasize tones, contrast and brightness within your
image.

The Creative Effects tab includes creative stylized tools
from other Topaz programs (Topaz Simplify and Topaz
Lens Effects). These creative effects are great for adding realistic, graphic and artistic effects to your image.
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It includes pre-loaded curve presets for quick curve
adjustments or you can simply click and drag to add/
move anchor points. Use the Reset button to revert
back to the default settings.

Features
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Quad Tone
Quad Tone allows for 4 different tones to be selected
and applied to different tonal regions within an image.

Original Image
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Effects Menu
The Effects menu features 8 default preset and 3 user
collections which helps to manage your user-made
presets - there’s over 200 default presets included in
Topaz B&W Effects.
Each Effect features a set of its own presets that can
be applied to your image. During your workflow you
can select the type of effect that you want and then
choose from one of the included presets in that category.

Features
As in the other Topaz programs, you also have a presets panel. You can create and save your own presets.
You also have the ability to export and import presets
- allowing you to share with your friends.
* Default presets that come with the program can not
be deleted.
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Effects can Not be added. However, you are able to
create new presets and add them to any of the
collections listed in the Effects Menu.

Features
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Preset Collections
The Effects category breaks all of the included presets
down into Collections - each offering a different style
of effects. Unique to Topaz are the Van Dyke Brown
Collection, Cyanotype Collection, Opalotype Collection and the Albumen Collection which all simulate
historical printing processes. This allows you to give
your image an authentic look.

Traditional Collection
Features simplified black and white conversions that
are very classic and minimalistic.

17
Classic Preset

Toned Collection
Traditional conversions infused with toned color.

Original Image

Sepia and Selenium I Preset
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Stylized Collection
Includes creative effects like poster effects, cartoon
effects, diffusion and more.

Cyanotype Collection
Presets here simulate the Cyanotype photographic
printing process, which results in a cyan or blue print.
Discovered and developed by Sir John Herschel in
1842, this process was popularized in engineering
circles to make blueprints. A simple and fun process,
multiple variations can be seen through toning and
development options.

18
Adaptive Diffusion Preset

Teal Dynamic Preset

To learn more about Effect Collections and other
Topaz B&W Effect’s features sign up for one of our
FREE webinars. www.topazlabs.com/webinars

Painterly Preset

Features
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Albumen Collection
The Albumen print was the most common photographic print used in the nineteenth century, and
represents 80% of all surviving 19th century photographs. Albumen prints can vary in color from purple
to chocolate brown. They fade to yellow, and the
highlights are often gold.

Coffee Dynamic Preset

Opalotype Collection
An early photographic printing process, Opalotypes
were printed on sheets of translucent white glass
called opal or milk glass. Opalotypes were sometimes
hand-tinted with colors to enhance their effect and
they have been compared the mood of a watercolor
or pastel.
Chocolate Dynamic Preset

Van Dyke Brown Collection
Presets here simulate the Van Dyke Brown photographic process, developed in the mid 19th century.
The process is named after the Flemish artist Sir
Anthony van Dyck (1599-1641), whose work is characterized by lush sepia and brown tonalities. Through
different toning and chemical options, prints will vary
in hue, strength and color.
Hand Tinted Cream Preset
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Split Screen View
Topaz B&W Effects 2 interface features a 2-screen split
viewing option for easy before and after comparison.

Features
			
Use the single screen button
			
to see the full image preview.
			
Use the 2-split button to see
			
before and after comparison.
Use the preview navigator (top right of interface) to pan
the preivew or drag the images around in the preview.
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Interface (Main View)
Although the Topaz BW Effects interface may look intimidating at first glance, don’t worry: it’s actually quite simple and
easy to use. You’ll soon be a pro after experimenting with it for a bit. In order to make sense of the function of each of
the various controls, we have divided the interface into a few sections:

3
1

4

2
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5

1. Presets/Effects Panel

2. Preview Window

3. Viewing Tools

4. Preview Navigator

5. Settings & Parameters

Pre-defined presets,
organized by type of
effect..

Displays the preview
of the original and adjusted image.

Tools that control zoom and
other viewing options.

Displays the region of the
preview image you are
currently focused on.

Quick buttons and sliders to adjust the
various effects.

Topaz B&W Effects

User Manual

Work Area

Interface (Tool Panel View)
Use the small double arrow to expand and collapse the preset panel. You can click the double arrow

or grab the

inside edge of the panel and drag it in or out.
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Work Area

Interface (No Panel View)
Use the small double arrow to expand and collapse the preset and tool panels. You can click the double arrow
or grab the inside edge of the panels and drag them in or out.
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Work Area

Interface (Preset Panel View)
Use the small double arrow to expand and collapse the tool panel. You can click the double arrow
inside edge of the panel and drag it in or out.

or grab the
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Preview Section
The Preview section is the main window that is centered in the B&W Effects interface. The preview
section shows you the original image and the processed preview of the image. Click on the image in
the preview window (or use the
button) to switch
between the Original and Preview tabs and compare
the filtered and un-filtered images.

Work Area
To pan the preview image, click and hold the left
mouse button on the preview image and drag it
around. When you let go of the mouse button, the
new portion of the image will be processed and the
result will be displayed.
You can also use SPACE bar or your numbered shortcut
keys “1” and “2” to switch back and forth between your
filtered and unfiltered image in the preview window.

25

Work Area

Topaz B&W Effects

User Manual

26

You can zoom in or out of the preview image by clicking the “+”, or “-” buttons above the main preview
image. You can also resize the window as well by
dragging the bottom right corner in and out.
The “Fit” button will fit the entire image into the preview window.
The “100%” button will zoom to 100% view.
If zoomed below 100% the preview image will be internally resized in order to speed up preview updating.
B&W Effects presets offer a convenient 1-click
workflow that is quick and simple.

The “Ctrl +” and “Ctrl –” keys zoom in and out of the
image, just like in Photoshop.
You can use the arrow keys to adjust the value of the
slider that is currently selected.
A complete list of the shortcut keys can be found in
the Shortcut Keys section later in this manual.
Photoshop and other host software support many Image
Modes, such as Grayscale, RGB, LAB, CMYK, etc. Images can also be 8, 16, or 32 bits per channel. Topaz B&W
Effects supports both 8 bits per channel and 16 bits per
channel. B&W Effects supports RGB mode only. To work
on black-and-white images, first convert them to RGB

Work Area
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Presets and Effects

Presets are pre-defined settings that you can recall and reapply to
any image at any time. They are a great way to speed up and simplify your workflow, and offer creative ideas.

1

We’ve included some default presets for you and, although they
won’t work for every single photograph, they serve as excellent
starting points.
1. Effects List
Lists all of the included effect collections that can be applied
to your images.
2.Preset Options

2
3

The preset options allow you to star your favorite presets,
save/delete presets (default presets cannot be deleted),
import/export presets for sharing, and take up to 99 “snap-
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4

3. Presets List
Lists all of the available presets for the
selected Effect.
4. Preset Preview
Provides a preview of the available presets included in the Effects list selected.
Scroll over the preset list to see each
preview.
5. Preset QuickLook View
View all of the presets in a collection at
the same time by clicking the grid icon to
the right of each Effect Collection in the
Effects list.

5
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Adding Presets
Sometimes it’s convenient to be able to define presets and save your settings for later use. To do this,
first adjust the Topaz B&W Effects parameters until
you’re satisfied with the result. Then, click on
.
Next, enter a preset name, select the type of image
that it is good for and then enter a description and
click “OK”. You can also select a second image category type that the preset is good for.
Note that if the name you’ve entered is the same as a
preset you’ve already defined then you will be asked if
overwrite the previous one.
Your preset will be automatically saved in “My Colection” (unless unchecked when saving). To apply it
later, just click it like any other preset.
Deleting Presets
If you’d like to delete a preset, click
desired preset selected.

with your

Please Note: Default presents cannot be overwritten
or deleted. Once you delete a preset it or overwrite
it, it cannot be retrieved.
Saved presets are located in the Topaz B&W Effects 2 “Presets”
folder:
C:\Program Files\Topaz Labs \ Topaz B&W Effects 2 \ Presets unless you’ve opted to install Topaz B&W Effects 2 into a different
directory.
Mac users have this folder at: HD / Library / ApplicationSupport /
TopazLabs / B&W Effects 2/ Presets.
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Importing Presets
To import a preset file, click the import icon..

This will open up a “Browse” box to import a saved
preset from your computer into Topaz B&W Effects.
This is useful if you have downloaded a preset file
that you’d like to use.

Work Area
Exporting Presets
To export the preset file to a certain location, click
“Export”.

Name your preset and save it to your desktop or
other specified location that you have reserved for
saved presets.
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You can then share this preset file with others who
may then import it.

Sharing Presets
Feel free to share your saved presets by emailing
them to your friends and having them put it into their
Topaz B &W Effects 2 Presets folder.

Visit the Topaz Labs Blog which features the latest
Photography, software and design information including
tutorials, videos, and thoughts about both Topaz and
non-Topaz topics.

Work Area
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Tools

1

You will use the various tools in the tool panel during
your workflow to make your image adjustments. The
available tools will change depending on the Effect
that is selected (from the Effects menu).

2

1. Preview Navigator - Displays the region of the
preview image you are currently focused on. You can
drag the preview navigator box around to pan your
image.
2. Quick Buttons - Use the quick buttons to make immediate enhancements to your image, without having
to open the adjustments panel. The quick buttons include applying a color filter, changing the brightness,
contrast, adaptive exposure and quick access to your
dodge/burn brushes.
3. Undo/Redo and Panel Control buttons - From the
left: Reset all back to default settings, collapse all
tabs, undo and redo your steps, hide the quickbuttons
and hide the preview navigator.
4. Sliders and Parameters - Controls the editing process using sliders to adjust the various effects.

Have more questions about Topaz B&W Effects or
any of the other Topaz software programs?
Check out the new Topaz Knowledge Base online at:
www.topazlabs.com/support/kb

3
4
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Menu

Check for Updates
Checks for available Topaz B&W Effects updates.

You can access Topaz B&W Effects’ menu by clicking on
the “Menu…” button at the bottom of the interface.

Click the Show Details button to get find out what’s
included in the update before you install.

Preferences
Select this to enable or disable the program tool tips,
turn off interactive sliders and much more. You can
also choose how many presets per row you would like
to have in the preset QuickLook grid view.

Enter Key
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Enter Key
Select this to enter your trial or purchased license key.

Work Area
Gallery
Select this to open up your Internet browser and go
to the Topaz B&W Effects image gallery to see other
user images enhanced with Topaz B&W Effects.
MyTopaz
Brings you to the Topaz community where you can
connect and interact with other Topaz users. Here
you can also participate in discussions and contests,
and share your favorite Topaz images.

What’s This?
Select this (or click F1) then click on a feature in the
B&W Effects interface to learn more about it.
Users Guide
Select it to pull up this user guide.

Tutorials
Brings you to the Topaz B&W Effects tutorials page
where you can access a variety of helpful video and
text tutorials. You can also submit tutorials that you
created here as well.
About
Select this to see what version of B&W Effects you
currently have.

Tech Support
Brings you to the Topaz Labs support page where
you can request assistance from our support specialists, contact our customer service team, retrieve lost
license keys, or browse through our Knowledge Base.
Product Info
Select this to go to the Topaz B&W Effects web page
to learn more about the Topaz B&W Effects plug-in.

To connect with other Topaz users, participate in Topaz
contests and to see the latest tips, tricks and tutorials sign
up for the new Topaz Forum online at:
www.topazlabs.com/forum
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Settings & Parameters

Conversion
This step includes basic tools for black and white conversion, using standard and adaptive exposure adjustments. Conversion also includes the tools to enhance
contrast and tone sensitivity.

Basic Exposure

This parameter offers advanced contrast and brightness control.

33
Contrast
Adjusts definition between areas of light and dark to
add more depth.
Brightness
Standard brightness adjustment parameter. Increasing
this parameter increases the overall brightness of the
image.
Boost Blacks
Advanced contrast control, that specifically targets
and boosts darker tones closer to black.
Boost Whites
Advanced contrast control, that specifically targets
and boosts lighter tones closer to white.

Topaz B&W Effects

User Manual

Adaptive Exposure

The Adaptive Exposure tab uses an adaptive technique
to enhance the dynamic range of your image. Here you
can apply a variety of tone mapped effects using the
unique sliders to adjust the range of the highest and
lowest luminance regions where detail is visible. You
can also correct exposure, balance lighting and redefine tonal values.

Settings & Parameters
Adaptive Exposure
Corrects the exposure of an image by balancing tonal
values. This setting works in conjunction with the
Regions slider. A setting of 0 disables adaptive exposure balancing while a setting of 1 applies full adaptive
exposure balancing.
Regions (see page 36 for more details)
The number of regions to divide the image into for
Adaptive Exposure processing. The larger this number
is, the more local contrast and detail enhancement
you’ll get.
Protect Highlights
Built-in protection from clipping highlights (the lightest
tones). Increasing this parameter reduces the harshness of highlights and reveals previously obscured detail in highlight areas. A setting of 0 disables highlight
protection.
Protect Shadows
Built-in recovery for shadow detail. Increasing this
parameter opens up the shadows and reveals previously obscured detail in the shadow areas. A setting of
0 disables shadow protection.
Detail
Determines the degree of detail enhancement applied
to stronger details in the image. A value greater
than 1.0 strengthens the details in the image while a
value less than 1.0 reduces and smooths details.
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Settings & Parameters

Detail Boost
The amount of detail enhancement applied to the
smaller details in the image. A value higher than 1.0
strengthens the weaker details in the image while a value less than 1.0 reduces the strength of smaller details.
This parameter affects mostly weak details. Strong
details should be adjusted using the Strength slider.
Process Details Independently
Allows you to adjust exposure and details separately.
When this box is checked, only underlying exposure
will be adjusted when you use the Exposure tab. The
details will only be adjusted through the Details tab.
This gives you extra flexibility in your image and tends
to reduce the overall noise and amount of “dirty area”
in the final image.
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Understanding Regions
So how exactly is a region determined within an image?
For each image, take the longest side, whether horizontal or vertical...divide this side into sections. How
many sections is determined by the region slider.
Then, using those sections divide the image into
squares. Each square is considered a region, and the
contrast is then adjusted in that local region (based on
the pixels).
So let’s take a closer look at Regions in action so we
can see just how they work. Please follow along with
the examples starting on the next page...
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Example 1:
For the first set of images, the adaptive exposure is set
at .4, and the only slider moved was the regions slider.

Now we will change the Regions to 7 - this shows how
the regions are determined:
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Original Image

Adaptive Exposure: .4; Regions: 1; When the Region is 1,
the entire image is the region.

Adaptive Exposure: .4; REgions: 7
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Example 2:
For this next set of images, Adaptive Exposure will stay
at .5, and the only slider moved is the Regions.

Adaptive Exposure: .5; Regions: 4

37

The standard setting for regions is 4...here is what that
would look like:

Then change the Regions to 40...
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Adaptive Exposure: .5; Regions: 40

Settings & Parameters
Color Sensitivity
Provides the tools to adjust the sensitivity of different
colors throughout the image
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Want access to more mini tutorials like the Regions
tutorial above? Then be sure to check out Topaz T3, which
features tips, tricks and tutorials to help you get the most
of your Topaz programs. ww.topazlabs.com/blog
Also be sure to join us for our Quick Tip Thursdays
webinar series. In less than 15 minutes you can learn
helpful tricks to improve your workflow or enhance your
creative abilities with your Topaz programs.
Check out the upcoming webinar schedule online at:
www.topazlabs.com/webinars

Red
Adjusts red sensitivity throughout the image, making
red tones appear brighter or darker.
Yellow
Adjusts yellow sensitivity throughout the image, making yellow tones appear brighter or darker.
Green
Adjusts green sensitivity throughout the image, making
green tones appear brighter or darker.
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Cyan
Adjusts cyan sensitivity throughout the image, making
cyan tones appear brighter or darker.

Settings & Parameters
Strength
Controls the strength of the simulated filter. Higher
values will have more contrast between the chosen
hue and the complimentary hue.

Blue
Adjusts blue sensitivity throughout the image, making
blue tones appear brighter or darker.
Magenta
Adjusts magenta sensitivity throughout the image,
making magenta tones appear brighter or darker.

Color Filter
Simulates a color filter being applied to your exposure/
conversion.

Hue
The color of the simulated filter. Image features with a
similar hue appear brighter, and image features with a
complimetarty hue appear darker.
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Curve Tool
Using the Curve Tool you can adjust image tonality to
help emphasize tones, contrast and brightness within
your image. Click and drag to add/move points, controlling image contrast, brightness and tone.

Settings & Parameters
Curves (drop down menu)
Includes pre-loaded curves presets for 1-click selection
and application.

Reset Button
Resets the curve back to the default values.

Creative Effects
The Creative Effects tab includes creative stylized tools
for adding realistic, graphic and artistic effects.

Histogram
Includes a histogram to show the tonal range of your
image.
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Simplify

Simplify offers the control to remove image detail with
a size-based technology. Different combinations of the
settings create many different possibilities.

Simplify Size
Defines the size of the details being simplified. Any
detail with a size below the selected value will be
removed, leaving behind only the larger features. The
value of this parameter is relative to the entire image’s
size.
Feature Boost
Boosts the main features in the image and exaggerates
details. Certain setting will start to create a painterly
artistic effect.

Want to learn more about Topaz and other popular
photography techniques? Be sure to check out our
Pro Insights series where you can learn to improve your
craft directly from the pro! www.topazlabs.com/blog

Diffusion

Diffusion simulates characteristics like those seen with
Diffusion filters, which help soften and spread out light.
They can also help create a hazy or dream-like effect.
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Softness
Adjusts the softnesss of the image. Increasing this
parameter will make the image appear to have a softer
focus.
Diffusion
The diffusion slider controls how much the light is diffused in the image. This can give the image a nice inner
glow - traditionally used for portraits to soften/smooth
the skin, especially on females.
Diffusion Transition
The Edge Transition slider controls how quickly one
area on tone transitions into the next. This will help to
further control/enhance the exact look of diffusion you
would like for your image.
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Posterize

Posterize separates image tone into several regions of
fewer tones, with abrupt changes from one tone to the
next.

Depth
This value dtermines how many tones are included. A
value of 2 will have only 2 tones and have almost no
depth. A value of 8 will have 8 tones and appear to
have more depth.
Poster Detail
Higher values will increase the amount of detail in your
posterized image.

Need more creative insight into the way your Topaz programs work or how to better your workflow? Check out
the Topaz Question of the week! Don’t forget to submit
yours too! www.topazlabs.com/blog

Settings & Parameters
Camera Shake

This tab simulates the effects of camera shake and allows you to apply it to your image.

Camera Shake
Applies motion blur (in the form of camera shake) to
the image. Ahigher value will produce a more blurred
effect.
Camera Shake Angle
Determines the angle of the applied camera shake
Double Image
Enabling this feature will create a double of your image
within the image.

Sign up for a FREE webinar to get advanced Topaz training
tips. Visit our webinars page to see upcoming classes.
You can also view past webinars anytime by visiting
www.youtube.com/topazlabs

42

Topaz B&W Effects

User Manual

Local Adjustments
Selectively apply image adjustments using an advanced
brush. Adjustments include burning, dodging, smoothing, selective detail and selective color. Also includes
local undo/redo (up to 4 steps) and a local reset all
button.

Settings & Parameters
Adjustment Type
Choose Dodge, Burn, smooth, detail or Color. Note
that the below adjustments will apply to whatever
type you are in.
Overall Strength
Advanced blending control over applied adjustments.
If dodging or burning is too weak or strong, the
strength slider allows for further control. Note that the
Color type does not include this option.
Brush Size
Controls the size of the brush.
Hardness
Controls the edge hardness of the brush. A value of 0
is 100% hard, while a value of 1.00 is 100% soft.
Edge Aware
Controls how edge aware the brush is. Higher values
indicate an increase in awareness, which is good for
precise selections. Lower values indicate less awareness, allowing for a more natural brush stroke and
transition.
Opacity
Controls the amount of transparency in the selective
adjustment that is being applied.
Eraser
The eraser tool allows you to brush over any area to
remove the adjustments made.
The Color adjustment type does not have
an Overall Strength slider selection.
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Finishing Touches
Apply important finishing touches, including toning,
vignettes and grain.

Settings & Parameters
Silver and Paper Tone

Toning control with option of two hues, one based on
Silver (the gray and dark tones of the image) and the
other on Paper (the whites of the image).
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Need some creative inspiration?
Checkout our new Photo Inspiration series to see
creative Topaz enhancements and learn how the users
created the look. Visit: www.topazlabs.com/blog

Tonal Strength
Increases the overall strength of tone applied.

Settings & Parameters
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Balance
Controls the balance of the two tones and where on
the tonal scale they are blended. At 0, the tones will
be equally applied. Positive values increase the amount
of Silver Tone. Negative values increase the amount of
Paper Tone.

Quad Tone

Quad Tone allows for 4 different tones to be selected
and applied to different tonal regions within an image.
With 4 gray tones, enhanced contrast and detail can be
easily applied. Selecting one color or 4, advanced toning and artistic effects can be applied.

Silver Hue
Color of the Silver Tone (the darker tones of the image).
Silver Tone Stregnth
Controls the strength of the Silver Tone.
Silver Hue
Color of the Paper Tone (the lighter tones of the image).
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Silver Tone Stregnth
Controls the strength of the Paper Tone.

Color 1 Region
Click on the corresponding color swatch and a color
picker will pop-up for a color to be selected. Once the
color is selected, use the Region 1 slider to select where
on the tonal scale that color is to be applied. (Hint:
Choose all colors first before moving Region sliders)
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Settings & Parameters

Color 2 Region
Click on the corresponding color swatch and a color
picker will pop-up for a color to be selected. Once the
color is selected, use the Region 1 slider to select where
on the tonal scale that color is to be applied. (Hint:
Choose all colors first before moving Region sliders)
Color 3 Region
Click on the corresponding color swatch and a color
picker will pop-up for a color to be selected. Once the
color is selected, use the Region 1 slider to select where
on the tonal scale that color is to be applied. (Hint:
Choose all colors first before moving Region sliders)
Color 4 Region
Click on the corresponding color swatch and a color
picker will pop-up for a color to be selected. Once the
color is selected, use the Region 1 slider to select where
on the tonal scale that color is to be applied. (Hint:
Choose all colors first before moving Region sliders)

Film Grain

Add true or simulated film grain to the image.
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Grain
Choose from the library of true grain options. And to
customize the grain, use the grain contrast and size
sliders.
Grain Contrast
Controls the contrast and separation of the grain.
Grain Size
Adjusts the size of grain applied. Lower values will
produce finer grain and higher values will have larger,
more visible grain.

Settings & Parameters
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Border

Use the tools here to add a border to your image.

Edge Exposure

Use the parameters here to adjust the exposure of
your edges.

Border Type
Choose a border type to be applied to the image.
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Size
Adjusts the size of the border being applied to the image.
Edge
Select which edge needs burning or dodging.
Edge Size
Determines the size of the exposure adjustment on the
side selected.

Have a Topaz’d image you want to share?
Add it to the growing user photo albums on the Topaz
Facebook page at: www.facebook.com/topazlabs

By Topaz User Simon Gelfand

Settings & Parameters
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Edge Exposure
Controls the value applied. A setting of 0 applies no
correction. Negative values are for dodging and positive values are for burning.

Vignette

Add a vignette to an image

Edge Transition
Controls the blend between the adjustment and the
origianl image. Lower values will have a short transition and higher values will have a longer, smoother
transition.
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Center Button
1-click vignette center-point selection.

Created By Topaz User Steve Rich

The basic tools for brightnes, contrast and saturation
are included for convenience. For extended control over
tone and color in your images, you can use the tools and
presets found in Topaz Adjust or Topaz Detail.

Vignette Strength
Controls how heavily the vignette is applied to the
image. A lower value will produce a darker vignette,
whereas a higher value will produce a lighter, whiter
vignette.
Vignette Size
Controls the size of the applied vignette. A higher
value will expand the vignette and a lower value will
contract it.
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Settings & Parameters

Vignette Transition
Controls the blend between the vignette and the
original image. The larger values will produce a longer
softer transition and the lower values will produce a
shorter transition.
Vignette Curvature
Controls the shape of the vignette. A value of 0 produces an oval or circle, depending on image dimensions. A value of 1 will produce a rectangle or square,
depending on image dimensions.

Transparency

Before - By Topaz User Lewis Kemper

Transparency allows for some of the original color to
be re-introduced into the image.

Overall Transparency
Determines the amount of original color to be re-introduced into the image. Note that only 50% of the original
color may be re-introduced.

After- By Topaz User Lewis Kemper
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Workflow

Sample Project
In this project, we will walk you through a quick example workflow to help you get acquainted with the tools and setup
of Topaz B&W Effects. This example will show you a basic workflow and introduce you to the layout of the program.
As you begin, you can choose a Collection type from the Effects
menu and then apply one of its presets to convert your image,
or you can start your work manually using the tabs and sliders in
the tool panel. Whether you decide to work with presets, manual
adjustments or both, you will be able to customize your conversion
and enhancements using the pre-defined workflow as indicated by
the numbered tab setup.
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So let’s take a look at the purpose of each tab and what tools and
features are inlcuded in each.
1. This step includes basic tools for black and white conversion, using
standard and adaptive exposure adjustments. Conversion also
includes the tools to enhance contrast and tone sensitivity.
2. This step features creative stylized tools including realistic, graphic
and artistic effects.
3. This step allows you to selectively apply image adjustments using an
advanced brush. Adjustments include burning, dodging and selective color.
4. This final steps is for applying important finishing touches to your image.
It includes toning, vignettes, grain and more.
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Workflow

So let’s get started. For this example we will start our work manually in the Conversion tab.
1. Clicking on the Conversion Tab will automatically convert your image to black and white. This will also reveal the included
sub-adjustment tabs. We will work our way down following the order of each included tab. Keep in mind that while this is the
recommended workflow, you do not have to work in this order and you may not need or want to every adjustment tool/tab on
your image. This enhancement workflow is extremely flexible so only apply the adjustments that you desire and feel free to skip
others.
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Important: Next to each sub-adjustment tab is a small checkbox.
To enable the effects in this tab be sure that the check box is Checked.
You can also uncheck it at anytime to disable the effects.
Each sub-tab also includes a reset button. Clicking this button will reset
all of the sliders in that tab to their default values.
The Basic Exposure tab provides advanced contrast and brightness control. You can also individually boost the vibrance of the
black and whites in your image.
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Workflow

Once you are happy with your selections move on to the Adaptive Exposure tab. Adaptive Exposure is a very unique addition
to B&W Effects. It allows you to simulate the creative exposure effects found in Topaz Adjust to create a High-Impact black and
white composition. This makes it easy to add detail and depth to your image. The Adaptive Exposure tab uses an adaptive technique to enhance the dynamic range of your image...giving it that WOW factor.
Here you can apply a variety of tone mapped effects using the unique sliders to adjust the range of the highest and lowest luminance regions where detail is visible. You can also correct exposure, balance lighting and redefine tonal values.
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For some users, simply making adjustments in the Basic Exposure and Adaptive Exposure tabs will be enough. However, for
those who want more flexibility over your conversion tone and color you may also want to use the Color Sensitivity, Color Filter
and Curve Tool. So let’s quickly take a look at what each of these tabs do.
Color Sensitivity provides the tools to adjust the sensitivity (luminosity) of different tones based upon the original colors
throughout the image.
Color Filter simulates a traditional color filter being applied to your exposure/conversion. This will change certain tones in your
image based upon which color filter is simulated. For example, choosing a red color filter will darken tones that were originally
blue and lighten tones that were originally red.
The Curve Tool controls image contrast, brightness and tone. It also includes a preset dropbox with predefined curve settings
that can quickly be applied.
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The Creative Effects tab features creative and stylized tools including realistic, graphic and artistic effects. Let’s take a look at
the included effects.

55

- Simplify offers the control to remove image detail with a size-based technology. Different combinations of the settings create
many different possibilities.
- Diffusion simulates characteristics like those seen with Diffusion filters, which help soften and spread out light. Diffusion filters
can also help create a hazy or dream-like effect.
- Posterize separates image tone into several regions of fewer tones, with abrupt changes from one tone to the next.
- Camera Shake applies motion blur (in the form of camera shake) to the image.
Only use this tab if you want to add a creative or artistic flare to your image, otherwise you can skip ahead to the Local Adjustment tab.
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The Local Adjustments tab allows you to selectively apply image adjustments using an
advanced, yet very intuitive brush. Adjustments include burning, dodging and selective color.
Dodge and Burn adjustment types are used to either lighten (dodge) or darken (burn)
specific areas of your image by increasing or limiting the exposure in those areas.
Use the Overall Strength slider to determine how strong or weak the dodge/burn is
applied to your image.
The Color adjustment type allows you to brush the original color back into your image.
Selecting Color reveals an opacity slider. This allows you to determine the
intensity of the color that is brushed back in. The higher the value the more of the
original color is brushed back. A lower value with give you a more faint and less
saturated color.
The Detail adjustment type allows you to enhance detail in your image by simply brusing
over an area.
The Smooth adjustment type allows you to brush smoothness into your image.
Use the Brush Size and hardness sliders to determine the brush characteristics.
Edge Aware controls how edge aware the brush is. Higher values indicate an
increase in awareness, which is good for precise selections. Lower values
indicate less awareness, allowing for a more natural brush stroke and transition.
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Finishing Touches is the final adjustment stage where you can add important finishing touches, including toning, vignettes, borders, edge exposure and grain.
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Once you are happy with your adjustments click OK to process your changes and save your image back to Photoshop or other compatible host program. And you’re all set!
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Achromatic - Without color.
Adjustment Layer – A layer that allows you to adjust the
look of an original image with out making it permanent.
With adjustment layers you can make various changes to
a layer without damaging it and go back and readjust it at
anytime.
Algorithm - Any bit of code or programming that defines a process.
Blur - Make or become unclear or less distinct.
Brightness - The degree to which a color sample appears to reflect light.
Chroma - Purity or intensity of color. The difference
of a color against the brightness of another color that
appears white under similar viewing conditions.
Color - The human perceptual response to different
wavelengths of light impinging on the photo receptors in the retina.
Color Cast - Tint or light hint of colour evenly covering an image - typcially an unwanted side effect. It is
usually most visible in light or medium density neutral
tones.
Color Profile - defines the range of colors that can appear in a digital photo.

Download - The process of transmitting or transferring data from one device to another.
Export - Outbound data transfer in a format that can
be used by other programs.
Filters - Transparent lens attachments used to change
the color, or other characteristics, of an image.
Grain - Lightly-speckled noise that is used to apply a
more natural look to an image.
HDR (High Dynamic Range) - Allows a greater dynamic
range of luminances between the lightest and darkest
areas of an image than standard digital imaging techniques or photographic methods. This wider dynamic
range allows HDR images to more accurately represent the wide range of intensity levels found in real
scenes, ranging from direct sunlight to faint starlight.
Highlights - The bright to white range of tones in an
image.
Hue - One of the main properties of a color, described
with names such as “red”, “yellow”, etc.
Import - Inbound data transfer into a file or document.
Opacity – The amount of transparency a layer has.

Contrast - The difference between light and dark
values.

Parameter - A numerical or other measurable factor
forming one of a set that defines a system or sets the
conditions of its operation.

Desaturate - Decreasing the intensity of a color (hue).

Photo-editing or Imaging software – Programs in
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which you can alter your photos and / or create digital
images. Depending on the software, you can improve
exposure, color and other attributes of your picture,
paint on it, add type, apply special effects, remove
noise, resize it, combine it with other pictures, prepare it for e-mail or posting on the web, output it to a
printer, or do any number of other manipulations or
edits.

Shadow - A dark area or shape produced by a body
coming between the rays of light and a surface.

Plug-in - A computing feature with the ability to be
added to a system to give extra features or functions.

Tone - The degree of lightness or darkness.

Preset - A pre-defined combination of parameters and
settings that is saved into a folder within Topaz B&W
Effects. Topaz provides default presets. A preview of
each preset can be seen in the preset preview window located at the top left hand side of the interface
above the preset list.
Preview- Shows the processed preview of the image.
RAW image - An image file format that contains untouched, “raw” pixel information straight from the
digital camera’s sensor. It has yet to translate the information in each pixel into the full color information,
so this format offers more control over how the final
JPEG or TIFF image is generated.
Refine – Improve (something) by making small changes to
make it more subtle and accurate.
RGB - Red, Green, Blue. The color model that is used
in digital cameras and by computer monitors.
Saturation - The difference of intensity within a specific hue.

Sharpness - The clarity of detail in a photo.
Smoothing - To make a surface more regular or consistent; free from perceptible projections, lumps, or
indentations.

Vignette- A fall-off or blockage in brightness at the
edges of an image.
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“I need a Topaz B&W Effects trial key.”
Visit http://www.topazlabs.com/downloads for a trial
key. Please check your Spam folder because your
Spam filter sometimes filters out the automated email.
If you need more time to evaluate, please contact us at:
www.topazlabs.com/support for an extended trial key.

“I can’t find Topaz B&W Effects in the Photoshop
Filters menu.”
If Photoshop was open when you installed then you
will need to restart Photoshop and then you should be
able to access it. If it is still not listed in your Filter menu
then do the following:
For Windows:
Please go to your preferences menu in Photoshop and
select Plug-ins. Check / enable the Additional Plug-ins
Folder option then click Choose. After that, please
navigate to: C: \ Program Files and select the Topaz
Labs folder. Then click Choose (or it may say Save /
OK) to save this back to Photoshop. Back in Photoshop
click OK to save your changes, then restart Photoshop.
Once Photoshop opens, go to your Filter menu and you
should be able to access Topaz.
For Mac:
Please go to your preferences menu in Photoshop and
select Plug-ins. Check / enable the Additional Plug-ins
Folder option then click Choose. After that, please
navigate to: Macintosh HD -> Library -> Application Support and select the Topaz Labs folder. Then click save /

Frequently Asked Questions
OK to save this back to Photoshop. Back in Photoshop
click OK to save your changes, then restart Photoshop.
Once Photoshop opens, go to your Filter menu and you
should be able to access Topaz.

“Do you have any other B&W Effects tutorials?”
Yes, please see pages 51 and 60 of this Topaz B&W Effects user guide.
You can also visit: http://www.topazlabs.com/tutorials/
bweffects or sign up for a free webinar at: http://www.
topazlabs.com/webinars
“I don’t have Photoshop, will B&W Effects work with
my Elements, Aperture, Lightroom, iPhoto Paint Shop
Pro, Photo Impact or Irfanview?”
Yes, you can use Topaz B&W Effects with any of the
above host programs. However, to use B&W Effects in
Aperture, Lightroom or iPhoto, you will need to download the free Topaz Fusion Express plug-in. For more
information please visit: www.topazlabs.com/fusion
“I already have photoFXlab/Fusion Express installed
for use with my other Topaz programs but B&W Effects 2 does not show up in the menus?”
B&W Effects 2 requires the latest version of photoFXlab
and Fusion Express. You will need to download from:
www.topazlabs.com/downloads and then install. After
that you will be able to access and use B&W Effects 2.
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“What are the limitations of the trial version of your
software?”
The only limit on the trial versions of the Topaz plug-ins
is time. The free trial versions are designed to enable
you to experience the full functionality of our plug-ins
for a 30-day trial period. After the trial period is up, you
will only be able to use the Topaz software by purchasing it. You will then receive a license key to activate the
plug-in, and the trial version will automatically become
the full version with no time limitations.

“If I use the 30-day trial version will I need to uninstall
the trial version before I upgrade to a full version?”
No, the Topaz trial software is designed to be unlocked
to become the full version simply by entering a license
key. The full license key will be e-mailed to you immediately after you purchase the software.
“Where do I enter my key?”
To enter your key please open an image in Photoshop.
Go to Filter -> Topaz Labs -> B&W Effects. Once the
program opens go to Menu -> Enter Key. Then copy &
paste or type in your license key and then select OK.
“I had Topaz B&W Effects as a trial, then I purchased.
How do I enter my new license key?”
You can enter your new license key by opening up an
image in Photoshop and go to Filter -> Topaz Labs ->
B&W Effects -> Menu -> Enter Key. Please remove the
trial key and enter your new purchased license key,
then select OK and you are all set.

Frequently Asked Questions
“My Topaz B&W Effects key doesn’t work!”
There are a couple of reasons why Topaz B&W Effects
might think your key is invalid.
First, make sure that your key is in the proper format.
It’ll be in the format “xxxxxx-xxxxxx-xxxxxx-xxxxxxxxxxxx” and will be all numbers in 30 digits in five
groups of six (no letters).
Second, make sure that as you’re entering the key
there is nothing in the space beforehand. This means
clicking, pressing Ctrl-A, and hitting delete to make sure
that absolutely nothing is in that field before you paste
in the key.
If it doesn’t work when you copy and paste, try typing
it out, and vice versa.
My Topaz filters are grayed out in the filter menu.
Please make sure that you are using a 8-bit or 16-bit
image that is in RGB color mode. Also, if your project
includes adjustment layers please make sure that you
are not on an adjustment layer. You will need to select
the image layer. This will allow you to access your Topaz programs.
I have a question not listed here.
Please visit our knowledge base online at:
http://www.topazlabs.com/support
If you are not able to find the answer there then contact our support specialists online at: www.topazlabs.
com/support or e-mail customer support at: help@
topazlabs.com

61

Topaz B&W Effects

User Manual

Connect with Topaz

Check out our new Forum and our blog for
tutorials, tips and updates from Topaz Labs!
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Follow us on Twitter for notifications of
recent news and easily get in touch with us
whenever you feel like it!

Find us on our Facebook page and network
with other Topaz users!

Participate in the entirely user-led Topaz
Flickr group for a helpful and highly active
community for Topaz Photoshop plug-ins!

Subscribe to our YouTube channel to keep
up with any newly released product video
tutorials!
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Contact Information
Topaz Labs LLC

4100 Spring Valley Road
Suite 103
Dallas, TX 75244

Technical Support

Visit: http://topazlabs.com/support/
Email: help@topazlabs.com

For more information
info@topazlabs.com

Topaz Labs LLC, a privately owned company in Dallas, Texas, focuses on developing advanced video and image enhancement technology. With today’s widespread use of digital still cameras, digital video cameras, and HDTV, the need for highquality digital images and videos has greatly increased. Topaz Labs’ mission is to bring practical state-of-the-art image and
video enhancement technology to both professionals and consumers.

Copyright © 2010 Topaz Labs, LLC. All rights reserved. http://www.topazlabs.com
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Be sure to check out the complete line up of Topaz products.
Topaz Photoshop Plug-ins for digital photography.		

Topaz Adjust creates
vibrant images that pop.
Includes tools for creative
exposure, detail, color and
pseudo HDR.

Topaz Lens Effects allows
you to create bokeh, add
vignettes and simulate a
variety of filter, lens and
specialty camera effects.

Topaz InFocus offers tools
for advanced sharpening
and minor blur reduction
to refine and improve
overall image quality.

Topaz DeJPEG eliminates jpeg
artifacts and restores optimal JPEG
image integrity, helping create
high-quality jpeg images.

Topaz B&W Effects is the
most versatile black and
white image converter.
Designed specifically for
creating and enhancing
high-impact B&W images.

Topaz DeNoise offers highquality noise reduction
tools that eliminate digital
image noise and recover
lost image detail.

Topaz ReMask is the
quickest, easiest and best
masking tool for complex
masking and removing
unwanted image backgrounds.

Topaz Detail features multilevel tools for control over
detail enhancement and
sharpening without edge
artifacts or halos.

Topaz Simplify is a digital
art tool that makes it easy
to transform digital images
into works of art in just a
few clicks.

Bring the power of Topaz to your
Aperture, iPhoto and
Lightoom workflow with the new
Fusion Express plug-in.

Go to http://www.topazlabs.com/downloads to get your 30-day free trial!

Topaz Clean features
unique smoothing, edge
and texture control for
enhancing portraits or stylizing images.
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